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Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.
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		REPORTINGAGENCY[0]: US Army Engineer & Research Center (ERDC)

		OCTOBER[0]: 2019
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		AMOUNT4[0]: 
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		BENEFITDESCRIPTION4[0]: 

		BENEFITDESCRIPTION3[0]: 

		BENEFITDESCRIPTION2[0]: 

		BENEFITDESCRIPTION1[0]: Lodging

		SOURCE1[0]: Department of Biology
Middle Tennessee State University
P.O. Box 60
Murfreesboro, TN  37132

		TRAVELERDATES3[0]: 3-4 October 2018

		LOCATION1[0]: Murfreesboro, TN

		Date1[0]: 4 October 2018

		SPONSOR1[0]: Dr. David Nelson, MTSU

		DESCRIPTION1[0]: Technical Presentation at Fall Seminar Series

		TITLE1[0]: Research Biologist, Environmental Laboratory

		NAME1[0]: Dr. Sandra Brasfield Newell

		AMOUNT8[0]: 120.00

		AMOUNT7[0]: 176.00

		AMOUNT6[0]: 414.00

		AMOUNT5[0]: 524.00
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		BENEFITDESCRIPTION5[0]: Air Transportation

		SOURCE2[0]: University of Southern California, 
Sea Grant Program, 3454 Trousdale Pkwy, CAS 200, Los Angeles, CA 90089

		TRAVELERDATES6[0]: 3-5 October 2018

		LOCATION2[0]: Sacramento, CA

		Date2[0]: 3-5 October 2018

		SPONSOR2[0]: Nick Sadrpour, USC Sea Grant Program

		DESCRIPTION2[0]: Review Panel for Sea-level Rise Adaptation & Coastal Resilience

		TITLE2[0]: Research Ecologist, Environmental Laboratory

		NAME2[0]: Dr. Tosin Sekoni

		AMOUNT12[0]: 

		AMOUNT11[0]: 658.00
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		INKIND12[0]: Off

		CHECK12[0]: Off

		INKIND11[0]: 1

		CHECK11[0]: Off
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		BENEFITDESCRIPTION11[0]: Per Diem

		BENEFITDESCRIPTION10[0]: Lodging

		BENEFITDESCRIPTION9[0]: Air Transportation

		TRAVELERDATES9[0]: 14-19 October 2018

		LOCATION3[0]: Florianopolis, Brazil

		Date3[0]: 15-19 October 2018

		SPONSOR3[0]: Professor Pedro de Souza Pereira

		DESCRIPTION3[0]: II Brazilian Symposium of Sandy Beaches

		TITLE3[0]: Technical Director, Coastal & Hydraulics Laboratory

		NAME3[0]: Dr. Julie D. Rosati

		AMOUNT16[0]: 

		AMOUNT15[0]: 
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		BENEFITDESCRIPTION13[0]: Air Transportation

		SOURCE4[0]: PIANC National Sections of Spain
Avenida del Camino de Santiago, 40, Edificio 2, Planta 3a
28050 Madrid, Spain

		TRAVELERDATES12[0]: 16-19 October 2018

		LOCATION4[0]: Seville, Spain

		Date4[0]: 17-19 October 2018

		SPONSOR4[0]: Manuel Arana Burgos, Subdirector

		DESCRIPTION4[0]: PIANC Mediterranean Days Keynote Speaker

		TITLE4[0]: Senior Research Scientist, Environmental Laboratory

		NAME4[0]: Dr. Todd S. Bridges

		SOURCE3[0]: Federal University of Pernambuco, Oceanography Dept.
Av. Arquitetura, Cidade Universitaria, Recife-PE-Brazil, CEP 50740-550
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		BENEFITDESCRIPTION19[0]: 

		BENEFITDESCRIPTION18[0]: 

		BENEFITDESCRIPTION17[0]: Registration Fee

		SOURCE9[0]: Great Minds in Stem
2465 Whittier Blvd., Suite 202
Montebello CA, 90640

		TRAVELERDATES15[0]: 17-21 October 2018

		LOCATION5[0]: Pasadena, CA

		Date5[0]: 17-21 October 2018

		SPONSOR5[0]: Great Minds in Stem

		DESCRIPTION5[0]: 2018 HENAAC Great Minds in STEM Conference

		TITLE5[0]: Research Civil Engineer,  Geotechnical & Structures Laboratory

		NAME5[0]: Omar Esquilin-Mangual

		AMOUNT24[0]: 

		AMOUNT23[0]: 

		AMOUNT22[0]: 

		AMOUNT21[0]: 800.00

		INKIND24[0]: Off

		CHECK24[0]: Off

		INKIND23[0]: Off

		CHECK23[0]: Off

		INKIND22[0]: Off

		CHECK22[0]: Off

		INKIND21[0]: 1

		CHECK21[0]: Off

		BENEFITDESCRIPTION24[0]: 

		BENEFITDESCRIPTION23[0]: 

		BENEFITDESCRIPTION22[0]: 

		BENEFITDESCRIPTION21[0]: Registration Fee

		SOURCE11[0]: Great Minds in Stem
2465 Whittier Blvd., Suite 202
Montebello CA, 90640

		TRAVELERDATES18[0]: 17-21 October 2018

		LOCATION6[0]: Pasadena, CA

		Date6[0]: 17-21 October 2018

		SPONSOR6[0]: Great Minds in Stem

		DESCRIPTION6[0]: 2018 HENAAC Great Minds in STEM Conference

		TITLE6[0]: Research Environmental Engineer, Environmental Laboratory

		NAME6[0]: Edith Martinez-Guerra

		AMOUNT28[0]: 

		AMOUNT27[0]: 

		AMOUNT26[0]: 1,593.69

		AMOUNT25[0]: 1,960.29

		INKIND28[0]: Off

		CHECK28[0]: Off

		INKIND27[0]: Off
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		INKIND26[0]: Off
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		BENEFITDESCRIPTION27[0]: 

		BENEFITDESCRIPTION26[0]: M&IE

		BENEFITDESCRIPTION25[0]: Air Transportation

		SOURCE13[0]: Helmholtz Centre for Environmental Research - UFZ, Dept. of Bioananlytical Ecotoxicology, Permoserstrasse 15
04318 Leipzig Germany

		TRAVELERDATES21[0]: 21-24 October 2018

		LOCATION7[0]: Leipzig, Germany

		Date7[0]: 22-23 October 2018

		SPONSOR6[1]: Dr. Stefan Scholz

		DESCRIPTION7[0]: Lecture presentation on chemical hazard assessment

		TITLE6[1]: Senior Scientist, Environmental Laboratory

		NAME7[0]: Dr. Edward J. Perkins

		AMOUNT32[0]: 

		AMOUNT31[0]: 994.00

		AMOUNT30[0]: 564.42
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		CHECK32[0]: Off
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		BENEFITDESCRIPTION29[0]: Air Transportation

		TRAVELERDATES24[0]: 21-27 October 2018

		LOCATION8[0]: 
Seoul, Korea

		Date8[0]: 22-26 October 2018

		SPONSOR8[0]: Dr. Jinhee Choi, Univ of Seoul

		DESCRIPTION8[0]: Workshop "Development of Adverse Outcome Pathway Network using AOP Xplore"

		TITLE8[0]: Research Biologist, Environmental Laboratory

		NAME8[0]: Dr. Lyle Burgoon

		AMOUNT36[0]: 

		AMOUNT35[0]: 

		AMOUNT34[0]: 277.00

		AMOUNT33[0]: 200.00

		INKIND36[0]: Off

		CHECK36[0]: Off
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		CHECK35[0]: Off
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		CHECK34[0]: Off

		INKIND33[0]: 1

		CHECK33[0]: Off

		BENEFITDESCRIPTION36[0]: 

		BENEFITDESCRIPTION35[0]: 

		BENEFITDESCRIPTION34[0]: Meals

		BENEFITDESCRIPTION33[0]: Registration Fee

		SOURCE17[0]: River Action, Inc.
822 E. River Drive
Davenport, Iowa 52803




		TRAVELERDATES27[0]: 23-25 October 2018

		LOCATION9[0]: Stoney Creek Conference Center, Moline, IL

		Date9[0]: 24-25 October 2018

		SPONSOR9[0]: Carol Downey, River Action

		DESCRIPTION9[0]: 11th Annual Upper Mississippi River Conference 2018

		TITLE9[0]: Research Ecologist, Environmental Laboratory

		NAME9[0]: Charles H. Theiling

		SOURCE15[0]: Korea Environmental Industry & Technology Institute, 613-2 Bulgwang-dong, Eunpyeong-gu, Seoul, South Korea





		form1[0]: 

		Page1[0]: 

		REPORTING_DEPARTMENT[0]: US Army Engineer & Research Center (ERDC)

		EVENT_DATES[0]: 29-30 November 2018

		AMOUNT[0]: 1,916.00

		EVENT_DATES[1]: 23-24 January 2019

		AMOUNT[1]: 

		EVENT_DATES[2]: 11-13 March 2019

		TRAVELER_NAME[0]: 

Dr. Benjamin D. Trump

		TRAVELER_TITLE[0]: 
Research Social Scientist, Environmental Laboratory

		EVENT_DESCRIPTION[0]: Emerging Leaders in Biosecurity Initiative Workshop

		LOCATION[0]: 
Washington, D.C.

		TRAVEL_DATES[0]: 
11-13 March 2019

		SOURCE[0]: John Hopkins Center for Health Security, John Hopkins Bloomberg School of Public Health,
621 E. Pratt St. Suite 210
Baltimore, MD  21202

		DESCRIPTION[0]: Air Transportation

		CHECK[0]: 

		IN_KIND[0]: X

		EVENT_SPONSOR[0]: Matthew Watson, John Hopkins Center for Health Security

		AMOUNT[2]: 250.00

		DESCRIPTION[1]: Lodging

		AMOUNT[3]: 

		DESCRIPTION[2]: 

		CHECK[1]: 

		IN_KIND[1]: 

		AMOUNT[4]: 

		IN_KIND[2]: 

		CHECK[2]: 

		DESCRIPTION[3]: 

		CHECK[3]: 

		IN_KIND[3]: X

		AMOUNT[5]: 362.00

		IN_KIND[4]: 

		CHECK[4]: 

		DESCRIPTION[4]: 

		CHECK[5]: 

		IN_KIND[5]: 

		AMOUNT[6]: 

		IN_KIND[6]: 

		CHECK[6]: 

		DESCRIPTION[5]: 

		AMOUNT[7]: 

		DESCRIPTION[6]: 

		AMOUNT[8]: 950.00

		EVENT_SPONSOR[1]: Gina Melaragno, Battelle Memorial Institute

		IN_KIND[7]: X

		CHECK[7]: 

		DESCRIPTION[7]: Registration Fee

		SOURCE[1]: Battelle Memorial Institute
505 King Avenue
Columbus, Ohio 43201

		TRAVEL_DATES[1]: 
11-14 February 2019

		LOCATION[1]: 
New Orleans, LA

		EVENT_DESCRIPTION[1]: 10th Int'l Conf on Remediation & Management of Contaminated Sediments

		TRAVELER_TITLE[1]: 
Research Civil Engineer, Environmental Laboratory 

		TRAVELER_NAME[1]: 

Dr. Mandy Michalsen

		EVENT_DATES[3]: 11-14 February 2019

		TRAVELER_NAME[2]: 

Elizabeth Murray

		TRAVELER_TITLE[2]: 
Research Biologist, Environmental Laboratory

		EVENT_DESCRIPTION[2]: Workshop "Use of Dredged Material to Protect Low-Lying Areas in Chesapeake Bay"

		LOCATION[2]: 
Annapolis, MD

		TRAVEL_DATES[2]: 
22-24 January 2019

		SOURCE[2]: University of Maryland Center for Environmental Science, PO Box 38, 146 Williams 
Street, 
Solomons, MD  20688

		DESCRIPTION[8]: Air Transportation

		CHECK[8]: 

		IN_KIND[8]: X

		EVENT_SPONSOR[2]: Dr. Mario Tamburri, University of Maryland

		AMOUNT[9]: 397.00

		DESCRIPTION[9]: Lodging

		AMOUNT[10]: 110.00

		DESCRIPTION[10]: 

		CHECK[9]: 

		IN_KIND[9]: 

		AMOUNT[11]: 

		IN_KIND[10]: X

		CHECK[10]: 

		DESCRIPTION[11]: Ground Trans

		CHECK[11]: 

		IN_KIND[11]: X

		AMOUNT[12]: 258.00

		IN_KIND[12]: X

		CHECK[12]: 

		DESCRIPTION[12]: Per Diem

		CHECK[13]: 

		IN_KIND[13]: X

		AMOUNT[13]: 

		IN_KIND[14]: 

		CHECK[14]: 

		DESCRIPTION[13]: 

		AMOUNT[14]: 619.00

		DESCRIPTION[14]: Lodging

		AMOUNT[15]: 1,500.00

		EVENT_SPONSOR[3]: Dr. Grant Martin, Senior Research Officer, Rhodes University

		IN_KIND[15]: X

		CHECK[15]: 

		DESCRIPTION[15]: Air Transportation

		SOURCE[3]: Centre for Biological Control, Dept. of Zoology & Entomology, Rhodes University, P.O. Box 94, Grahamstown 6140, Eastern Cape, South Africa

		TRAVEL_DATES[3]: 23 February - 4 March 2019

		LOCATION[3]: Rhodes University, Grahamstown, South Africa

		EVENT_DESCRIPTION[3]: Meeting at Rhodes University to assess invasive plant infestations 

		TRAVELER_TITLE[3]: 
Research Biologist, Environmental Laboratory

		TRAVELER_NAME[3]: 

Nathan Harms

		EVENT_DATES[4]: 23 February - 4 March 2019

		TRAVELER_NAME[4]: 

Dr. Natalia Vinas

		TRAVELER_TITLE[4]: 
Research Biologist, Environmental Laboratory

		EVENT_DESCRIPTION[4]: "Fish and Amphibian Embryos as Alternative Models in Toxicology and Teratology" Meeting

		LOCATION[4]: 
Paris, France

		TRAVEL_DATES[4]: 

		SOURCE[4]: Centre for Safety of Substances and Products; National Institute for Public Health and the Environment (RIVM), 3720 BA Bilthoven
The Netherlands

		DESCRIPTION[16]: Air Transportation

		CHECK[16]: 

		IN_KIND[16]: X

		EVENT_SPONSOR[4]: Joop de Knecht, Nat'l Institute for Public Health & Environment

		PAGE[0]: 3

		TOTAL_PAGES[0]: 4
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		Page2[0]: 

		EVENT_DATES[0]: 22-24 March 2019

		AMOUNT[0]: 28.00

		EVENT_DATES[1]: 23-28 March 2019

		AMOUNT[1]: 

		EVENT_DATES[2]: 

		TRAVELER_NAME[0]: 
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		SOURCE[0]: 
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		AMOUNT[6]: 

		IN_KIND[6]: 

		CHECK[6]: 

		DESCRIPTION[5]: 

		AMOUNT[7]: 

		DESCRIPTION[6]: 

		AMOUNT[8]: 

		EVENT_SPONSOR[1]: 

		IN_KIND[7]: 

		CHECK[7]: 

		DESCRIPTION[7]: 

		SOURCE[1]: 

		TRAVEL_DATES[1]: 

		LOCATION[1]: 

		EVENT_DESCRIPTION[1]: 

		TRAVELER_TITLE[1]: 

		TRAVELER_NAME[1]: 

		EVENT_DATES[3]: 

		TRAVELER_NAME[2]: 

Charles T. Decker

		TRAVELER_TITLE[2]: Operational Energy Manager, Construction Engineering Research Laboratory

		EVENT_DESCRIPTION[2]: Attendance at an operational test  for NATO Deployed Force Infrastructure Power Monitoring

		LOCATION[2]: Arctic Test Base
Resolute Bay, Canada

		TRAVEL_DATES[2]: 
23-28 March 2019

		SOURCE[2]: Canadian Ministry of Defense

		DESCRIPTION[8]: Air Transportation

		CHECK[8]: 

		IN_KIND[8]: X

		EVENT_SPONSOR[2]: 
Canadian Ministry of Defense

		AMOUNT[9]: 5,923.00

		DESCRIPTION[9]: Lodging

		AMOUNT[10]: 

		DESCRIPTION[10]: 

		CHECK[9]: 

		IN_KIND[9]: 

		AMOUNT[11]: 

		IN_KIND[10]: 

		CHECK[10]: 

		DESCRIPTION[11]: 

		CHECK[11]: 

		IN_KIND[11]: X

		AMOUNT[12]: 1,224.00

		IN_KIND[12]: X

		CHECK[12]: 

		DESCRIPTION[12]: 

		CHECK[13]: 

		IN_KIND[13]: 

		AMOUNT[13]: 

		IN_KIND[14]: 

		CHECK[14]: 

		DESCRIPTION[13]: 

		AMOUNT[14]: 

		DESCRIPTION[14]: Meal (Incl w Reg)

		AMOUNT[15]: 999.00

		EVENT_SPONSOR[3]: Construction Users Roundtable

		IN_KIND[15]: X

		CHECK[15]: 

		DESCRIPTION[15]: Registration

		SOURCE[3]: Construction Users Roundtable 
4100 Executive Park Drive, Suite 210 Cincinnati, Ohio 45241

		TRAVEL_DATES[3]: 
10-12 February 2019

		LOCATION[3]: 
Orlando, FL


		EVENT_DESCRIPTION[3]: CURT National Conference 2019

		TRAVELER_TITLE[3]: 
Mechanical Engineer, Construction Engineering Research Laboratory

		TRAVELER_NAME[3]: 

Megan Kreiger

		EVENT_DATES[4]: 11-13 February 2019

		TRAVELER_NAME[4]: 

Alan J. Kennedy

		TRAVELER_TITLE[4]: 
Research Biologist, Environmental Laboratory

		EVENT_DESCRIPTION[4]: Graduate Student Orientation

		LOCATION[4]: Blacksburg, VA

		TRAVEL_DATES[4]: 
22-24 March 2019

		SOURCE[4]: Macromolecules Innovation Institute, Virginia Polytechnic Institute & State University, ICTAS II, Suite 130
Blacksburg, VA  24060

		DESCRIPTION[16]: Air Transportation

		CHECK[16]: 

		IN_KIND[16]: X

		EVENT_SPONSOR[4]: Kim Felix, Virginia Polytechnic Institute & State University

		AMOUNT[16]: 445.00

		DESCRIPTION[17]: Lodging

		AMOUNT[17]: 100.00

		DESCRIPTION[18]: 

		CHECK[17]: 
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		IN_KIND[19]: X

		AMOUNT[19]: 260.00
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SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 10 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 








SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
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REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 30 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 








SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 10 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 








PAGE OF PAGES YEAR


1 8 2019


Agency Contact: Mr. Scott E. Handley


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


Eller, Walton Champ of Americas 11/1/2018 Guadalajara, MX Transportation x 1,000.00$                             


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x 1,500.00$                             


SFC USA Shooting 11/10/2018 11/01/2018 - 
11/10/2018 Entry Fees x 500.00$                                


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Haldeman, Derek Champ of Americas 11/1/2018 Guadalajara, MX Transportation x 1,000.00$                             


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x 1,500.00$                             


SSG USA Shooting 11/10/2018 11/01/2018 - 
11/10/2018 Entry Fees x 500.00$                                


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jungman, Phillip Champ of Americas 11/1/2018 Guadalajara, MX Transportation x 1,000.00$                             


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x 1,500.00$                             


SPC USA Shooting 11/10/2018 11/01/2018 - 
11/10/2018 Entry Fees x 500.00$                                


2


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


1


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


EX


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


scott.e.handley.civ@mail.mil


OGE Form-1353
(OGE-Approved Alternative for SF-326)


February 2011


1353 Travel Report for ARMY MARKSMANSHIP UNIT, ENTER YOUR ORGANIZATION HERE for the reporting period April 30, 2017 - Sept 30, 2017


No.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and 
policies, see 41 CFR part 304-1.


USAREC, including USAMU
X


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND TOTAL AMOUNTBENEFIT 


DESCRIPTIONTRAVELER EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


BENEFIT SOURCE


REPORTING 
PERIOD: 1 


October 2018 - 
31 March 2019







TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


English, Amber Champ of Americas 11/1/2018 Guadalajara, MX Transportation x 1,000.00$                             


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x 1,500.00$                             


2 LT USA Shooting 11/10/2018 11/01/2018 - 
11/10/2018 Entry Fees x 500.00$                                


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Elliot, Christian Champ of Americas 11/1/2018 Guadalajara, MX Transportation x 1,000.00$                             


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x 1,500.00$                             


SPC USA Shooting 11/10/2018 11/01/2018 - 
11/10/2018 Entry Fees x 500.00$                                


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Taylor, Dustan Champ of Americas 11/1/2018 Guadalajara, MX Transportation x 1,000.00$                             


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x 1,500.00$                             


SGT USA Shooting 11/10/2018 11/01/2018 - 
11/10/2018 Entry Fees x 500.00$                                


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sunderman, Patrick Champ of Americas 11/2/2018 Guadalajara, MX Transportation x 500.00$                                


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x x 1,000.00$                             


SFC USA Shooting 11/10/2018 11/02/2018 - 
11/11/2018 Entry Fees x 200.00$                                


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Norton, George Champ of Americas 11/2/2018 Guadalajara, MX Transportation x 500.00$                                


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x x 1,000.00$                             


SFC USA Shooting 11/10/2018 11/02/2018 - 
11/11/2018 Entry Fees x 200.00$                                


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Beard, Sarah Champ of Americas 11/2/2018 Guadalajara, MX Transportation x  $                               500.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x x  $                            1,100.00 


2LT USA Shooting 11/10/2018 10/31/2018 - 
11/10/2018 Entry Fees x  $                               200.00 


8


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


7


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


6


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


5


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


4


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


3


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sherry, Tim Champ of Americas 11/8/2018 Guadalajara, MX Transportation x  $                               500.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x x  $                               450.00 


SPC USA Shooting 11/11/2018 11/08/2018 - 
11/11/2018 Entry Fees x  $                               100.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Joss, John Selection Comp 12/2/2018 Colorado Springs Transportation x  $                               296.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals


SSG USA Shooting 12/5/2018 11/25/2018 - 
12/07/2018 Entry Fees x  $                               330.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Nguyen, Kevin Selection Comp 11/26/2018 Colorado Springs Transportation x  $                               296.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals


SSG USA Shooting 12/5/2018 11/25/2018 - 
12/07/2018 Entry Fees X  $                               330.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Stith, Emily Selection Comp 11/26/2018 Colorado Springs Transportation X  $                               296.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals


PFC USA Shooting 12/5/2018 11/25/2018 - 
12/07/2018 Entry Fees X  $                               330.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sherry, Tim AUT/GER Competition 1/20/2019 Innsbruck AUT & 
Munich GER Transportation X  $                            1,250.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals X  $                            1,200.00 


SPC USA Shooting 1/27/2019 01/15/2019 - 
01/27/2019 Entry Fees X  $                               150.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Stith, Emily AUT/GER Competition 1/20/2019 Innsbruck AUT & 
Munich GER Transportation X  $                            1,250.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals X  $                            1,200.00 


PFC USA Shooting 1/27/2019 01/15/2019 - 
01/27/2019 Entry Fees X  $                               150.00 


USA Shooting


TRAVEL DATE(S)


13


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


14


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


10


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


12


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


11


LOCATION BENEFIT SOURCE


9


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Beard, Sarah Robert Mitchell 2/4/2019 Colorado Springs Transportation x  $                               296.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               800.00 


2LT USA Shooting 2/10/2019 02/03/2019 - 
02/12/2018 Entry Fees x  $                               200.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sunderman, Patrick Robert Mitchell 2/4/2019 Colorado Springs Transportation x  $                               296.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               800.00 


SPC USA Shooting 2/10/2019 02/03/2019 - 
02/12/2018 Entry Fees x  $                               200.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


McPhail, Michael Robert Mitchell 2/6/2019 Colorado Springs Transportation x  $                               296.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               600.00 


SFC USA Shooting 2/10/2019 02/05/2019 - 
02/12/2018 Entry Fees x  $                               200.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Joss, John Robert Mitchell 2/6/2019 Colorado Springs Transportation x  $                               296.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               600.00 


SSG USA Shooting 2/10/2019 02/05/2019 - 
02/12/2018 Entry Fees x  $                               200.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Stith, Emily Robert Mitchell 2/4/2019 Colorado Springs Transportation x  $                               296.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               800.00 


PFC USA Shooting 2/10/2019 02/03/2019 - 
02/12/2018 Entry Fees x  $                               200.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Eller, Walton Training Camp 2/5/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                            1,000.00 


SFC USA Shooting 2/11/2019 02/05/2019 - 
02/11/2019 Entry Fees


17


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


19


LOCATION


18


LOCATION BENEFIT SOURCE


BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


20


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


15


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


16


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


USA Shooting


TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Richmond, Josh Training Camp 2/5/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                            1,000.00 


SFC USA Shooting 2/11/2019 02/05/2019 - 
02/11/2019 Entry Fees


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Haldeman, Derek Training Camp 2/5/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                            1,000.00 


SSG USA Shooting 2/11/2019 02/05/2019 - 
02/11/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Rennert, Alex Training Camp 2/5/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                            1,000.00 


SPC USA Shooting 2/11/2019 02/05/2019 - 
02/11/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jungman, Phillip Training Camp 2/5/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                            1,000.00 


PFC USA Shooting 2/11/2019 02/05/2019 - 
02/11/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


English, Amber Training Camp 2/5/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                            1,000.00 


2 LT USA Shooting 2/11/2019 02/05/2019 - 
02/11/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Beard, Sarah New Deli World Cup 2/20/2019 New Delhi India Transportation x  $                            1,600.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x x  $                            1,750.00 


2 LT USA Shooting 2/28/2019 02/17/2019 - 
02/28/2019 Entry Fees x  $                               200.00 


26


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


25


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


24


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


23


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


22


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


21


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Gray, Henry New Deli World Cup 2/20/2019 New Delhi India Transportation x  $                            1,600.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x x  $                            1,750.00 


SFC USA Shooting 2/28/2019 02/17/2019 - 
02/28/2019 Entry Fees x  $                               200.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sherry, Tim New Deli World Cup 2/20/2019 New Delhi India Transportation x  $                            1,600.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x x  $                            1,750.00 


SPC USA Shooting 2/28/2019 02/17/2019 - 
02/28/2019 Entry Fees x  $                               200.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Eller, Walton Spring Selection Match 2/25/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               600.00 


SFC USA Shooting 3/5/2019 02/25/2019 - 
03/06/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Richmond, Josh Spring Selection Match 2/25/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               600.00 


SFC USA Shooting 3/5/2019 02/25/2019 - 
03/06/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Haldeman, Derek Spring Selection Match 2/25/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               600.00 


SSG USA Shooting 3/5/2019 02/25/2019 - 
03/06/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Inman, Seth Spring Selection Match 2/25/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               600.00 


SSG USA Shooting 3/5/2019 02/25/2019 - 
03/06/2019


28


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


27


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


32


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


31


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


30


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


29


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Rennert, Alex Spring Selection Match 2/25/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               600.00 


SPC USA Shooting 3/5/2019 02/25/2019 - 
03/06/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jungman, Phillip Spring Selection Match 2/25/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               600.00 


SPC USA Shooting 3/5/2019 02/25/2019 - 
03/06/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


English, Amber Spring Selection Match 2/25/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               600.00 


2 LT USA Shooting 3/5/2019 02/25/2019 - 
03/06/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Hinton, Will Spring Selection Match 2/25/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                               600.00 


SPC USA Shooting 3/5/2019 02/25/2019 - 
03/06/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Tozier, Rachel Spring Selection Match 2/25/2019 Tucson AZ Transportation


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                            1,000.00 


SPC USA Shooting 3/5/2019 02/25/2019 - 
03/06/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Eller, Walton World Cup 3/15/2019 Alcapulco MEX Transportation x  $                            1,000.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                            1,000.00 


SFC USA Shooting 3/26/2019 03/11/2019 - 
03/26/2019


38


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


37


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


36


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


35


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


34


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


33


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Rennert, Alex World Cup 3/15/2019 Alcapulco MEX Transportation x  $                            1,000.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging/meals x  $                            1,000.00 


SPC USA Shooting 3/26/2019 03/11/2019 - 
03/26/2019


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Muth, Frank M AUSA Annual Meeting 10/8/2019 Washington, DC Meals x  $                               345.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


MG AUSA 10/10/2018 10/07/2018 -
10/11/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Gavia, Tabitha A. AUSA Annual Meeting 10/8/2018 Washington, DC Meals x  $                               300.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


CSM AUSA 10/10/2018 10/07/2018 -
10/11/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


DeGolyer, Troy A. AUSA ILW Global Force 
Symposium & Exposition


3/26/2019 Huntsville, AL Transportation, 
Lodging, & Meals x


1,226.21$                      


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


CW5 AUSA 3/28/2019 03/25/2018 -
03/29/2018                            


42


LOCATION BENEFIT SOURCE


AUSA


TRAVEL DATE(S)


41


LOCATION BENEFIT SOURCE


AUSA


TRAVEL DATE(S)


40


LOCATION BENEFIT SOURCE


AUSA


TRAVEL DATE(S)


39


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)





		Sheet1






SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 30 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 








Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


2019


Agency Contact: LTC James P. Leary


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Robert Brown Annual Meeting & 
Exposition 10/8/2018 Washington D.C Meals X $195 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


USARPAC CG Association of the United 
States Army (AUSA) 10/10/2018 10/08/2018- 


10/10/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Benjamin Jones Annual Meeting & 
Exposition 10/8/2018 Washington D.C Meals x $280 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel                 x $1,154.08 


USARPAC CSM AUSA 10/10/2018 10/07/2018- 
10/11/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Eward Downing Annual Meeting & 
Exposition 10/8/2018 Canberra, Australia Hotel x $1,155 


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


HEADQUARTERS, DEPT OF THE ARMY
US ARMY PACIFIC NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2018- MARCH 


31, 2019


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2019


3


LOCATION


Asia Pacific Forum 
Pacific Rim Foundation 


OGE Form-1353
(OGE-Approved Alternative for SF-326)


February 2011


1353 Travel Report for HEADQUARTERS, DEPT OF THE ARMY, US ARMY PACIFIC for the reporting period APRIL 1 - SEPTEMBER 30, 2019


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


james.p.leary4.mil@mail.mil


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


AUSA 


BENEFIT SOURCE


AUSA 


BENEFIT SOURCE


AUSA 


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation x $230 


RDECOM Science 
Advisor to USARPAC AUSA 10/10/2018 10/06/2018- 


10/11/2018
          
Meal/Miscell                  X $1,079.25 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Christopher Dunlap Annual Meeting & 
Exposition 10/5/2018 Washington D.C Hotel x $1,442.60 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Driver to USARPAC CG AUSA 10/10/2018 10/05/2018-
10/10/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jason Baker Annual Meeting & 
Exposition 10/5/2018 Washington D.C Hotel x $1,437.78 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


             
Transportation                 x $845.80 


Public Affair Chief AUSA 10/10/2018 10/05/2018- 
10/11/2018


         
Meals/Miscell                x $594.81 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jonathan Norwood Annual Meeting & 
Exposition 10/8/2018 Washington D.C Meals x $45.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Strategic Effects 
Director AUSA 10/10/2018 10/07/2018 - 


10/11/2018                            


LOCATION


TRAVEL DATE(S)


3
TRAVEL DATE(S)


4


LOCATION


TRAVEL DATE(S)


5


6


LOCATION


TRAVEL DATE(S)


BENEFIT SOURCE


AUSA 


BENEFIT SOURCE


AUSA 


BENEFIT SOURCE


AUSA 





		Instruction Sheet

		Agency Acronym

		USARPAC






SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 10 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR
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STANDARD FORM 326 (2-98) 
 








SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 30 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)
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NAME


TITLE


DESCRIPTION
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DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 








PAGE OF PAGES YEAR


1 2 2019


Agency Contact:
MAJ Matthew 
Gallagher


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Andrew Biaglow


Accrediatation Board for 
Engineering and 
Technology (ABET) 
Evaluation


9/30/2018 Orono, ME Hotel X $307.38 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $400 


Professor ABET 10/2/2018 09/29/2018-
10/02/2018 Meals X $150 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Richard Melnyk


Accrediatation Board for 
Engineering and 
Technology (ABET) 
Evaluation


10/7/2018 Lawrence, KS Hotel X $324.45 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Transportation 
Air/Rental Car X X 841.07


COL ABET 10/9/2018 10/06/2018-
10/10/2018 Meals X $77.10 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Brock Barry


National Council of 
Examiners for Engineering 
and Surveying (NCEES) 
Committee meeting


10/26/2018 Clemson, SC Hotel X $257.52 


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


United States Military Academy
West Point NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2018- MARCH 


31, 2019


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2019


3


LOCATION


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


845-938-8570


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


ABET


BENEFIT SOURCE


ABET


BENEFIT SOURCE


NCEES


BENEFIT SOURCE







BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


 
TRAVELER TITLE EVENT SPONSOR ENDING DATE 


[MM/DD/YYYY]


Transportation 
Air/Rental 
Car/Parking/Milea
ge


X X $596.33 


Professor NCEES 10/27/2018 10/25/2018-
10/27/2018 Meals X $84.50 


TRAVEL DATE(S)







PAGE OF PAGES YEAR


2 2 2019


Agency Contact: MAJ Gallagher


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Christopher Korpela Drone Days 3/26/2019 Zagreb, Croatia Hotel X $139 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation X $2,189 


LTC University of Zagreb 3/27/2019 03/24/2019-
03/27/2019 Meals X $154 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Scott Halstead West Point Society of 
Oregon Founders Day 3/9/2019 Tualatin, OR Hotel X $300 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $60 


COL WPS of Oregon 3/9/2019 03/08/2019-
03/10/2019                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Bogue Waller Avaition Week Network 
Laureate Awards 3/14/2019 Washington, DC Hotel X $291.97 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Transportation/ 
Air X $326.59 


Cadet Aviation Week 3/14/2019 03/14/2019-
03/15/2019                            


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2019845-938-8570


BENEFIT 
DESCRIPTION


United States Military Academy
West Point


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2018- MARCH 


31, 2019


2


Asia Pacific Forum 
Pacific Rim Foundation EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


3


LOCATION


TRAVEL DATE(S)


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.
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PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE TOTAL 
AMOUNT


NEGATIVE 
REPORT


BENEFIT SOURCE


University of Zagreb


BENEFIT SOURCE


WPS of Oregon


BENEFIT SOURCE


Aviation Week


BENEFIT SOURCE
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AUTHORIZED FOR LOCAL REPRODUCTION


TRAVELER 
(Name/Title)


EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND 
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


STANDARD FORM 326A (2-98) 
Prescribed by GSA/OGE (41 CFR 304-1)


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED 
FROM A NON-FEDERAL SOURCE-CONTINUATION
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TRAVELER 
(Name/Title)


EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND 
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


STANDARD FORM 326A (2-98) BACK 
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BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


STANDARD FORM 326A (2-98) 
Prescribed by GSA/OGE (41 CFR 304-1)


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED 
FROM A NON-FEDERAL SOURCE-CONTINUATION
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SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 10 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION
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Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
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                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 1 2019


Agency Contact: Ms. Carolyn Morris


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


United States Army Cyber Command NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X X


REPORTING 
PERIOD: 


OCTOBER 1, 
2018- MARCH 


31, 2019


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2019


3


LOCATION


TRAVEL DATE(S)


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


carolyn.g.morris3.civ@mail.mil


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 10 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


Far East District (CEPOF), US Army Corps of Engineers 2019


1 1


8 Apr 2019X X







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 








Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP
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                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 1 2019


Agency Contact: Ms. Marie Joiner


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jeffrey Broadwater Los Angeles Rams 11/1/2018 Los Angeles, CA


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Parking 50/day x $50 


Commander, NTC & 
Fort Irwin 11/1/2018 11/2018-11/2018


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Andrew H. Boyd Landpower Education 
Forum 10/23/2018 Arlington, VA Hotel X $280 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $332 


BN S-3, 1AD AUSA 10/23/2018 10/22/2018-
10/24/2018 Misc X $115 


2


LOCATION


Association of the United 
States Army (AUSA)


TRAVEL DATE(S)


BENEFIT SOURCE


OGE Form-1353
(OGE-Approved Alternative for SF-326)


February 2011


1353 Travel Report for FORSCOM, HQ, US Forces Command, Ft Bragg, NC for the reporting period APRIL 1, 2018 - SEPTEMBER 30, 2018


No.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


US Army
FORSCOM


marie.a.joiner.civ@mail.mil


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


TOTAL 
AMOUNTTRAVELER EVENT DESCRIPTION & 


EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


BENEFIT SOURCE BENEFIT 
DESCRIPTION


October 1, 
2018 - March 


31, 2019


1


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


EX


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)





		Instruction Sheet

		Agency Acronym

		1353 Report






 


 
 


FCJA                                8 May 2019 
 
MEMORANDUM FOR Ethics, Legislation, and Government Information Practices Branch, 
Administrative Law Division, Office of the Judge Advocate General, ATTN: Mr. Arthur F. 
Kaff, 2200 Army Pentagon, Room 3D548, Washington, DC 20310-2200 
 
SUBJECT:  Consolidated Semi-Annual 31 U.S.C. 1353 Travel Report for U.S. Army Futures 
Command (AFC), 1 Oct 18 – 31 Mar 19  
 
 
1. The 31 U.S.C. 1353 travel reports from AFC HQ and subordinate commands and 
organizations for the reporting period of 1 Oct 2018 to 31 Mar 2019 have been consolidated 
and are enclosed. 
 
2. The following constitute the negative reports: 
 
 a.   AFC, Operations Directorate, Austin, TX. 
 b.   AFC, Futures and Concepts Center (FCC), TRAC, Fort Leavenworth, KS. 
 c. AFC, FCC, Joint Modernization CMD, Fort Bliss, TX. 
 d.   AFC, FCC, Directorate of Concepts, Fort Eustis, VA. 
 e.  AFC, Intelligence CDID, Fort Huachuca, AZ. 
 f.   AFC, FCC, Maneuver CDID, Fort Benning, GA. 
 g.  AFC, Mission Command Center of Excellence, Fort Leavenworth, KS. 
    
3. The following reported travel benefits during this period: 
 
 a.   AFC, HQ, Austin, TX. 
 b.   CCDC, HQ, Aberdeen Proving Ground, MD. 
 c. APNT CFT, Redstone Arsenal, AL. 
 d.   AMD CFT, Fort Sill, OK. 
 e.  FVL CFT, Redstone Arsenal, AL. 
 f. LRPF CFT, Fort Sill OK. 
 g.  Network CFT, Aberdeen Proving Ground, MD. 
 h.  NGCV CFT, Detroit Arsenal, MI. 
      i.   SL CFT, Fort Benning, GA. 
  j.  STE CFT, Orlando, FL. 
      k.  AFC FCC HQ, Fort Eustis, VA. 
       l.  AFC FCC, Directorate of Integration, Human Dimension, Fort Eustis, VA. 
 m. AvCoE CDID, Fort Rucker, AL. 
 n.  CCoE CDID, Fort Gordon, GA. 
      o.  FCoE, CDID, Fort Sill, OK. 
      p.  MSCoE CDID, Fort Leonard Wood, MO. 
 q.  SCoE CDID, Fort Lee, VA. 
 
4. Point of contact for this action is MAJ John Dohn, (703)545-7612. 
 
 
       


JOHN C. DOHN II 
      MAJ, JA 
      Attorney-Advisor 


DEPARTMENT OF THE ARMY 
OFFICE OF THE STAFF JUDGE ADVOCATE 


U.S. ARMY FUTURES COMMAND 
210 WEST 7TH STREET 
AUSTIN, TX  78701-3099 
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